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6 Literature Reviews with MAXQDA 

 

Introduction 

Working with specialized literature is a core element of many scientific disciplines. It is difficult to imagine a 
report for a project, master’s thesis, or dissertation in which previous research has not been systematically 
analyzed and presented (Creswell, 2016, pp. 58–66). As more and more publishers make their journals and 
publications accessible online, the creation of literature reviews has become easier and more efficient. 
MAXQDA is suitable for day-to-day work with literature and the creation of literature reviews (for example, 
the preparation of theory chapters and research reports) as well as for systematic reviews and the prepara-
tion of research results in meta-analysis. In particular, MAXQDA can be used to manage notes and create 
summaries to support the writing process. When working with literature, bibliographic information (author, 
year of publication, etc.) must be distinguished from the content of the literature. MAXQDA focuses primar-
ily on the content and is not a specialized reference management software, however, data from such pro-
grams can be imported into MAXQDA for further processing. 

In this guide: 

• Working with bibliographic data and full texts 

• Importing data from reference management programs and (online) databases 

• Everyday tasks with literature and summaries 

• Conducting literature reviews 

• Options for creating systematic reviews 
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Working with bibliographic data and full texts from reference 
managers 

MAXQDA offers you the option to import bibliographic data from reference management programs such as 
Mendeley, Endnote, Citavi and Zotero. Like MAXQDA, these reference managers use project files, meaning 
databases, containing all collected bibliographic information. The smallest unit of such a project is a biblio-
graphic reference (author, title, etc.) which may also contain links to websites, keywords, abstracts, full texts 
and other information. 

MAXQDA is compatible with all reference management programs that are able to export their literature da-
tabases in RIS format, which is a standard format for bibliographic information. This is the case with all 
mainstream literature management programs such as Citavi, DocEar, Endnote, JabRef, Mendeley and Zotero, 
i.e. you can transfer selected or all literature entries from these programs to MAXQDA. With the following 
programs it is possible to import the assigned full texts into MAXQDA in addition to the literature references: 

• Citavi (import function available spring 2020) 

• Endnote 

• Mendeley 

• Zotero 

When imported into MAXQDA, each literature entry becomes its own text document. If full texts are im-
ported, MAXQDA automatically connects the full text to the literature entry with an internal link. The indi-
vidual information in the literature entries is automatically coded for later analysis so that, for example, all 
titles or abstracts can be compiled and searched. The attachments can be automatically coded during the 
import with the keywords assigned to them, and the notes for a literature entry can be saved as a document 
memo with the corresponding attachment. The following picture shows that MAXQDA creates two docu-
ment groups when importing references including associated full texts, "REFERENCES" and "REFERENCES > 
ATTACHMENTS", in this case only one reference has been imported (Bryman 2007) and the full text has 
been saved in the document group for attachments. 
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File breakdown into references and attachments when importing RIS data   

The RIS file format for bibliographic data 

RIS is the short form for “Research Information System Format”. RIS files are simple text files in which all ex-
ported literature entries are listed one after the other. RIS files contain so called ”tags“, which consist of two 
letters and are followed by the corresponding information. Important tags include for example: 

TY – Type of reference, always marks the beginning of a new entry 

ID – Unique identification number for each entry 

AU – Author 

TI – Title 

PY – Publication date 

ER – Closes entry, always located at end of entry 

A detailed description of all RIS format tags can be found on Wikipedia at https://en.wikipe-
dia.org/wiki/RIS_(file_format). An example of RIS source data is listed below: 

TY  - BOOK 
AU  - McLuhan, Marshall 
AU  - Fiore, Quentin 
TI  - The medium is the message: An inventory of effects 
PY  - 1967 
CY  - New York, NY 
PB  - Bantam Books 
ER  - 
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Export literature data from Citavi, Endnote, Mendeley, or Zotero 

Before importing literature data into MAXQDA, you must export the desired data from your literature man-
agement program in RIS format. Exporting works in a similar way for all four programs.  

Export from Citavi 

1. Select all entries to be exported in the list of references on the left. If you want to export all entries, no 
selection is necessary. 

2. Start the export wizard via File > Export > Export... In the first step it may be necessary to add the "RIS" 

filter via + Add export filter. 

3. In the next step, select Save to text file: and click Browse... to specify the file name and location for the 

file. 

4. If you want to perform exports of this type again in the future, save the procedure as an "export tem-
plate" as a last step. 

Export from Endnote 

1. Select the literature entries you want to export. 

2. Select File > Export… from the main menu. 

3. Enter a file name and select a directory. 

4. Set the file type to “Text Only” and the output style to “Ref-
Man (RIS) Export” as shown in the following picture. If this 
output style is not available, open the selection list and select 
“Select Another Style…” at the top, where you can search for 
the output style. 

5. Click Save. 

Export from Mendeley 

1. Select the literature entries that you want to export. 

2. Select File > Export... from the main menu. 
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3. Assign a file name and select a location. 

4. Set the file type to "RIS - Research Information Systems (*.ris)". 

5. Click Save. 

Export from Zotero 

1. Right-click on a collection and choose Export Collection… Alterna-

tively, choose File > Export Library… from the main menu to export 

the entire library. 

2. In the appearing dialog select “RIS” as the format. 

3. If you want to export the notes and the associated files (especially 
the full texts), make sure to check the corresponding boxes for Ex-
port Notes and Export Files. 

4. After clicking OK, assign a file name and select a directory. 

5. Click Save. 

Import and automatic pre-coding in MAXQDA 

RIS files can be imported into MAXQDA via Import > Reference Manager Data. A selection dialog box will 

then appear in which the relevant file with the extension RIS or TXT is selected. During the import, the fol-
lowing occurs: 

• A document group “REFERENCES” is created in the “Document System”. 

• All literature entries are added to the newly created document group as individual text documents. The 
entries are sorted alphabetically and marked with their own symbols. 

• The document name consists of the surnames and first names of the authors as well as the year. In the 

case of two authors these are linked with “&”, in the case of three or more authors only the first author 
is mentioned and “et al.” is added.  
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Imported literature data in MAXQDA 

• In the “Code System” a code “REFERENCES” with the two subcodes “RIS” and “KEYWORDS” is gener-
ated. The code “RIS” contains all RIS tags used in the import file as subcodes, e.g. “Type of reference” 
or “Abstract”. The code “KEYWORDS” contains all keywords assigned in the literature references as 
subcodes. 

• When importing, all references are automatically coded by coding each text section with the corre-
sponding RIS code. 

• Each keyword in the literature reference is coded with the corresponding keyword in the code system. 

• DOI links are inserted into the text as hyperlinks, so that you can access the online version of a publica-
tion directly if required. 

If attachments are imported, the following will also happen: 

• A document group “REFERENCES > ATTACHMENTS” is created in the “Document System”. 

Keywords als Codes 

Bibliographische Informationen 
als Textdokument 

Link zum PDF mit Volltext 
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• All attachments are imported into this document group as separate documents. 

• The documents retain their file names and are sorted in alphabetical ascending order of their references. 

The sorting of the document names is therefore not necessarily alphabetical and the same document 
names may occur several times, e.g. if there are several documents with “Table of Contents”. 

And if references and attachments are imported: 

• Internal links are additionally created, which link the literature reference with the corresponding attach-

ments, so that you can jump back and forth between literature reference and full text with a single click. 
In the literature reference, the internal link can be found in the “Link to PDF (L1)” section (the name 
comes from the RIS format and also applies if it is a file format other than PDF). In the appendix, the in-
ternal link is placed at the beginning of the document. 

Five pieces of information which may also be important for future selections are also stored as document 
variables: 

• RIS_Type (Type of Reference) – text variable 

• RIS_Author (First Author) – text variable 

• RIS_Title (Title) – text variable 

• RIS_Reference-ID (Identification number) – integer variable 

• RIS_Year (Year of publication) – integer variable 

These variables are created as system variables and cannot be changed by the user. 

 

Imported variable values for each document 
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Working with literature data  

Following the import and automatic pre-coding, the bibliographic data is made available in MAXQDA as nor-
mal text. This means the data can be searched, coded, linked, edited and have memos added for further 
qualitative and quantitative content analysis (Kuckartz & Rädiker, 2019). Now you can answer questions 
such as: 

• How often are specific authors named? 

• Which topics are represented? 

• How has the focus on specific topics shifted? 

• Are there more journal articles or monographs on a specific topic? 

• To what extent have journal article titles changed over time? 

Here are three different initial ideas for starting your analysis: 

1. Right-click on a keyword in the code system and select the function Activate Documents Containing this 
Code. MAXQDA will then activate all literature entries and attachments to which this keyword has been 

assigned. 

2. Double click on “RIS > Abstract” to open all abstracts in the “Coded Segments” overview. Start the 
Smart Coding Tool by clicking on the symbol bearing the same name in the toolbar to encode and sys-

tematize the abstracts. 

3. Activate the document group “REFERENCES” and activate the code “RIS > Title” to list all titles in the 
“Retrieved Segments” window. Click on the Word Cloud icon to start an analysis of the (most common) 

words in the title. 
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Organizing and analyzing literature and summaries with 
MAXQDA 

Working with literature – both online and offline – is one of the most important activities not only in re-
search and teaching, but also in NGOs, institutions and for the purposes of market research. Typical tasks 
when working with literature include finding and reading relevant publications, identifying and marking im-
portant points, understanding arguments, and extracting, compiling and comparing texts. MAXQDA is an 
excellent tool for these daily tasks. In a series of blogposts, Elgen Sauerborn (2014) and Uta-Kristina Meyer 
(2014) describe how they create summaries and notes while reading relevant literature for their research, 
and manage them with MAXQDA. Based on their work and our own experiences, we suggest the following 
procedure: 

1. As far as possible, all available literature sources for the research are imported into a MAXQDA project. 

2. Summaries are created as individual documents in MAXQDA, whereby the reference information (au-
thor, year, title) is used as the document name, ideally in the exact citation style which will be used in 
the later bibliography. Consequently, authors can be easily searched for in the “Document System” by 
their document name. 

3. In-document memos, further information about the sources can be managed, such as questions arising 
from particular arguments, criticism of particular publications, or whether the source is important for 
your own work. 

4. The “Code System” is created following the chapters of the report, with codes following the same order 
as in the later work. Summaries or parts of the original documents suitable for citation will be coded 
with these codes. 

5. As the report is written, the corresponding codes are activated so all of the important coded segments 
are compiled in the “Retrieved Segments” window. 

6. This basis makes writing easy, eliminating the risk of overlooking an important point or reference and 
helping the user to “write up” the work. 

7. After completing the work, the sources, summaries, notes, and coded segments remain available. When 
you’re working on a similar topic at a later date, this work can be accessed, creating a foundation on 
which to add further references and summaries. 
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Creating literature reviews with MAXQDA 

What is meant by the term “literature review”? Arlene Fink provides the following definition: “A research 
literature review is a systematic, explicit, and reproducible method for identifying, evaluating, and synthesiz-
ing the existing body of completed and recorded work produced by researchers, scholars, and practitioners”. 
(Fink, 2010, p. 3) 

A literature review as explained in this way is conducted on a specific topic or research question. The objec-
tive is to determine the current state of research and/or the scientific discussion with regard to a particular 
field of knowledge. The focus may be on different pre-determined aspects, for example theoretical or meth-
odological aspects. A literature review represents a specific form of secondary analysis, as it is not a matter 
of new, independent research but rather a review of research that has already been conducted. A literature 
review, like an essay, is frequently written by an individual researcher. It systematically presents substantial 
research results, identifies controversies, and summarizes the state of scientific discourse in a specific field. A 
literature review is always an explanatory text, not simply a list of sources. 

Literature reviews can be created as embedded reviews (embedded within a dissertation or research report, 
for example) or as stand-alone reviews. The latter are frequently referred to as “systematic reviews”. As a 
rule, systematic reviews are concerned with the research results in relation to a specific question, and with 
identifying any gaps in the research. This is not usually the case with general embedded reviews, which is 
not to say that these are unsystematic or eclectic. Traditionally, however, stand-alone reviews focus more 
heavily on quantitative aspects. 

Work phases when creating a literature review 

Based on the work of Fink (2019), Boland et al. (2017), Hart (2017), Gough et al. (2017) und Heyvaert et al. 
(2016) six phases for the creation of a literature review can be identified: 

1. Formulation of research questions and objectives of the review. The research question should be pre-
cisely formulated in order to lead the review. 

2. Selection of bibliographic databases, which today are normally online databases. 

3. Determination of search terms within these databases. 

4. Application of practical and methodological criteria for the selection of high-quality scientific literature. 



16 Literature Reviews with MAXQDA 

 

5. Conducting the review. This includes, among other aspects: importing bibliographic data and eventually 
full texts; definition of variables such as author, year of publication, etc.; thematic coding of significant 
text segments, writing notes and summaries. 

6. Synthesis of results and writing up the review, either in the form of a qualitative description of results or 
in case of a quantitative meta-analysis as a calculation of statistical characteristic values and measures. 

MAXQDA can provide valuable support in all phases, particularly in the thematic and content development 
of primary sources in phases 5 and 6. Before describing the possibilities offered by MAXQDA for this type of 
work, the differences between MAXQDA and reference management programs such as Endnote, Citavi, 
Mendeley, Zotero, etc. should be considered. Endnote and the like allow the collection, management and 
citation of primary, online and offline sources. The focus of these programs is the management of biblio-
graphic input and the creation of bibliographies corresponding to the different regulations of a large num-
ber of scientific journals and publishers. For example, the widely-used Zotero program (www.zotero.org) 
searches for bibliographic information in online catalogs and booksellers such as Amazon, and allows this 
information to be stored in a local database and to be provided with keywords and metadata. Reference lists 
can later be exported in various citation styles (for example, in the widely-used APA style). While reference 
management programs focus on the bibliographic data, MAXQDA focuses on the content and allows for the 
thematic coding and systematic, qualitative and quantitative analysis of this content. MAXQDA is therefore 
not primarily used for the collection of bibliographic data (although this is possible), nor for the creation of 
reference lists for publications. However, as described above, MAXQDA allows the user to import biblio-
graphic data from reference management programs. 

But now, we return to a description of the phases of creating a literature review with MAXQDA. Literature 
reviews are valuable not only as overviews of the current state of knowledge in a particular field, they also 
situate the research within a wider context and debate within the scientific community. The six phases of 
creating a literature review are described in greater detail below. 

Phase 1: Formulation of research questions and objectives of the review 

Similar to a research project, a literature review begins with the formulation of the research field and ques-
tion(s) as well as the objectives. However, the question is formulated somewhat more broadly than would 
normally be the case for a research project. If the focus is overly narrow, sources that are relevant but do not 
initially appear to be central to the research could be overlooked. In MAXQDA, the research question and 
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objectives are best presented in the form of a free memo (via Analysis > Free Memo) as in the following ex-
ample: 

Memo title: Literature search on data analysis and integration in mixed methods research 
 
The goal of the literature search is to evaluate the current state of debate concerning the topic of data analy-
sis/integration in mixed methods research. Well-known authors in the mixed methods research community 
see the integration of qualitative and quantitative as the primary challenge of mixed methods research. The 
review aims to compile the most important positions. Since mixed methods discourse is conducted in English, 
only English-language literature should be taken into account. The review will cover the years 2014-2016, and 
will be limited to the leading journal on this topic, the Journal of Mixed Methods Research. 

Phase 2: Selection of bibliographic databases 

The next step is a targeted search for sources that could present information about the topic in question. In 
a traditional library, literature is identified by means of keywords and keyword catalogs, retrieved from the 
shelves, then taken to the workspace and placed on the desk. When working with computers and searching 
in appropriate databases, the principle is similar. The researcher explores databases and scientific journals, 
saves search hits, and selects sources that are presumed to contribute to the review. 

Next, it is important to decide exactly where and what to look for; in other words, to select the bibliographic 
databases and define the search terms. Normally the databases are online, and hundreds of public and pri-
vate databases exist. The most popular international databases are PubMed (Medicine), MEDLINE (Medicine), 
ERIC (Education science), JSTOR (various), LexisNexis (economics and law), PsycINFO (Psychology), Social Sci-
ence Citation Index and Sociological Abstracts (social sciences) (Fink, 2019, pp. 17–21). Also to be noted are 
private databases such as Springerlink, the portal for the Springer International Publishing AG, and the data-
bases of journals and periodicals such as that from Sage Publications, which is indispensable for research in 
the fields of methods and methodology. 

A further consideration is whether to include only English-language sources in the search. 

Phase 3: Determination of search terms 

After these specifications, the next step is to determine search terms. These could be single words or combi-
nations of multiple words. Nearly all databases offer the possibility for advanced searches, in which you can 
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formulate more complex conditions, for example linking search terms with the logical operators AND and 
OR. 

Example: In the Journal of Mixed Methods Research (JMMR), a search is conducted for all entries concerning 
the theme “data analysis”. The search is restricted to the years 2014-2016. Other possible search terms would 
be “triangulation” and “integration”, but in the following example the search is restricted to “data analysis”. 
The search on the JMMR website (https://mmr.sagepub.com/search) results in 57 hits. 
In the next step, the compilation of results on the website can be checked for relevance on the website, or 
the full list of results can be imported into MAXQDA and checked there. In this example, it is more efficient 
to import the results into MAXQDA. When exporting from the Sage Publications website, it is important to 
ensure that both the citation and the abstract are exported. The RIS format should be selected from the list of 
available formats. The file can be imported into MAXQDA via the menu function Import > Reference Manager 
Data. 

Phase 4: Application of practical and methodological criteria for the selection of high-quality scientific 
literature 

This phase concerns the selection of relevant literature, that is to say the literature that was found in the da-
tabase search is now examined to determine if it falls within the narrower area of the research question, and 
whether it fulfills the objectives of the review. 

Practical as well as methodological criteria of this selection process should be documented. Practical criteria 
are those which relate to the practical accessibility, language, and type of publication. For example, for a 
study on environmental awareness in Europe, only results in the most common languages, possibly only in 
English, would be considered. In addition, the search would be restricted to only the most important social 
science journals. Methodological criteria for this review could be, for example, the quality and manner of 
sampling, or the “seriousness” of the institution carrying out the study. It is possible that for methodological 
reasons, sources based on online surveys would be excluded because they used a convenience sample. 

For the earlier example of the literature review of data analysis in mixed methods research, all of the biblio-
graphic search hits were imported into MAXQDA. The sources now appear in the “Document System”. The 
following figure shows how MAXQDA appears after this information is imported. 
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Imported RIS file with search results in “Journal of Mixed Methods Research” 

The RIS format tags are found in the “Code System”. Here it can be seen that an abstract is available for 
only 49 of the 57 sources. The list of document variables displayed on the right shows that five tags are also 
available as variables for later selections, namely type of publication, author, title, ID, and year of publication. 

The next step is to systematically read each abstract in order to decide if the source is relevant or not. It is 
advisable to set up two (or more) new document groups to in the “Document System” to which the results 
can be moved according to their relevance. The names of the document groups should indicate their func-
tions, for example “Relevant sources” and “Less relevant sources”. Sources that do not contribute to the 
review can be deleted immediately. If there is any doubt concerning where to assign a source when reading 
the abstract, the full text can be obtained by clicking the link coded with the tag „DO_DOI“ or with the tag 
“UR_Web/URL” in the “Document Browser”. This will open the information page in the Sage Publications 
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database, which contains a link leading to the full text (assuming you have access to the sources via your li-
brary). Reading the full text provides a solid basis on which to classify the text as relevant or less relevant. 

Other variables which allow the user to make selections or comparisons and recognize trends can be defined 
in this phase of the literature review. For example, the variable “RIS_Year” allows for the creation of a table 
or chart showing the distribution of sources by year. 

There may be other primary sources outside the results of the database search that should be included in the 
review. In principle, all types of sources, including audio and video sources, can be imported into MAXQDA. 
Sources such as books that cannot be borrowed may only be available as scanned copies. Such scanned 
sources can also be included in the literature review. 

Hints for scanned sources: If no digitized version of a relevant source is available, the only option is to use 
scanned pages. This results in a photo or PDF file. Using software such as Adobe Acrobat, you can perform an 
OCR text recognition procedure. This is strongly recommended, as subsequent searches can be performed for 
words in the text and all word-related functions in MAXQDA including MAXDictio are also available for use. 

If the sources have been classified according to their relevance, particularly relevant publications can be im-
ported as full texts. It is best to create a new document group (for example, “Primary literature”) and to 
download and import full texts into this folder. Ideally, the full text and bibliographic reference should be 
linked: 

1. Open the full text. 

2. Open the bibliographic reference in the “Second Document Browser”. 

3. Highlight the first word (or first paragraph) in the full text and select Insert Internal Link from the context 

menu. 

4. Highlight the first word (or first paragraph) in the bibliographic reference and select Insert Internal Link 

from the context menu. 

For many databases, particularly private databases, you may only download full texts if you have authoriza-
tion to do so. This is the case at most universities, and all members of the university may have access. It may 
be necessary to log into the university network via VPN. 
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Phase 5: Conducting the review 

The process of conducting a literature review varies depending on the nature of the research questions and 
the objectives of the review as well as the range of the sources. In addition, the process depends on the time 
available for the preparation of the review. If little time is available, you have to restrict the material and 
tighten the formulation of practical and methodological criteria (see Phase 4). In this case, your review will 
be based mainly on the abstracts and not on the more extensive full texts. The following are some of the 
possibilities MAXQDA offers for conducting a literature review: 

Working with word clouds 

What are the central themes of a text and the key terms that are used? These can be easily explored by 
right-clicking on the full text and selecting the Word Cloud option. Alternatively, you can create a word 
cloud for parts of the bibliographic data (titles or abstracts) by retrieving the relevant segments and starting 
the word cloud function in the “Retrieved Segments” window. Nonsensical words or words that are not rel-
evant in the context of the review can be added to the stop list. 

Exploring full texts and working with memos 

In view of the abundance of publications available on almost every topic, it is often hard to read an entire 
book or journal article. Using the context search in the “Document Browser”, you can search specifically for 
the presence of key terms, which greatly reduces the extent of text passages that need to be read inten-
sively. Questions which arise, alongside ideas and core statements, can then be stored as memos attached to 
the corresponding text passages. The overall assessment, evaluation and criticism of a text can be stored as a 
document memo in the “Document System”. 

Emphasizing important text passages 

Reading a text and underlining important points is a common practice. You can work in the same way when 
creating literature reviews in MAXQDA: five distinct colors are available for color coding text passages. The 
marked passages can be easily located at a later time. In some cases, it may be useful to mark the text pas-
sages with a thematic code rather than color coding. 
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Exploring the frequency of words and terms used in the sources 

Using the word frequency function (part of the MAXDictio module), you can analyze the frequency of words 
in one or more documents. In addition, a differentiated word frequency analysis can be performed on docu-
ments, document groups and document sets. As with word clouds, nonsensical words can be added to the 
stop list and excluded from the analysis. 

Writing summaries 

Summarizing text and extracting interesting passages is one of the classic techniques of literature work. In 
MAXQDA, a document group “Summaries” should first be defined, in which all summaries and excerpts are 
stored. Next, select the option New Text Document from the context menu of this new document group. A 

new document will appear in the “Document Browser” in Edit Mode, where you can start to write a sum-
mary. If the full text has been imported, it can be opened in the “Second Document Browser”, allowing the 
user to read the source text and write the summary concurrently. The text segment and the corresponding 
summary can be linked using document links. 

The name of the summary should also contain the author and year; furthermore, the summary should be 
linked to the bibliographic reference using the procedure described above. 

Automatic coding of text segments 

The text can be searched for interesting key words and the results coded automatically using the function 
Analysis > Lexical search. The range of text passages to be coded can be freely selected by the user (search 

hit, sentence, several sentences, paragraph). Following automatic coding, the coded segments can be re-
trieved and explored further. 

Manual thematic coding of significant text passages 

It is possible to code the relevant text passages when the primary text is available, which is normally the case 
with journal articles. In this case, working with thematic codes that are as close as possible to the research 
questions in the scope of the review is recommended. By means of specific labeling, you can tag passages 
that are suitable for later quotations. For this purpose, a specific code, for example “Suitable for quotation” 
can be defined. Alternatively, the comment function or a weight score can be used. For each coded seg-
ment, a short comment can be added, in this case for example, “Quotation”. Later, in the Overview of 
Coded Segments, you can sort by the comment column so that all potential quotes are listed together. It is 
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also possible to assign a weight score to any coded segment. Later, you can retrieve just the text passages 
which have been coded under a selected theme or allocated a specific weight score. 

Distinguishing, coding, and statistically analyzing different dimensions 

For a specific content area in the literature, for example the research design, specific dimensions can be 
identified and defined as subcodes, for example “Explanatory sequential design”, “Exploratory sequential 
design”, or “Convergent design”. Using the option Subcode Statistics in the context menu of the “Code Sys-

tem”, the frequency of the different design types can be determined and displayed as a table or graph. 

Visual representation of themes and sources 

MAXQDA’s visual tools can also be used very effectively for literature reviews. We assume here that thematic 
coding of relevant texts has already taken place, either manually or using automatic coding of search items. 

• The Code Matrix Browser displays the themes covered and their respective frequency per text in a com-
parative table. 

• The Code Relations Browser displays the simultaneous occurrence of pairs of themes in a comparative ta-

ble. 

• The Single-Case Model (available in Visual Tools > MAXMaps) represents the coded themes and their re-
spective frequencies for a selected source in a schematic diagram. 

• The Single-Code Model (also available in MAXMaps) displays a selected theme and its coded segments, 

the code memo and the memos linked to the code in a schematic diagram. 

Writing thematic summaries and creating summary tables 

This technique uses MAXQDA’s function Analysis > Summary Grid. This makes it possible to write thematic 

compilations and present them in comparative tables (“Summary Tables”). In order to use this technique, it 
is a prerequisite that relevant text passages have been thematically coded beforehand. 

Quantitative evaluation of themes 

Quantitative aspects can also be relevant to literature reviews. For example, it is possible to sort and count 
sources according to variables (e.g. year of publication) and answer questions such as “How are the sources 
distributed over time?” or “Has the investigation of the topic ‘Data analysis/integration’ increased or de-
creased during the period of study?” Statistical tables with absolute and relative frequencies as well as bar 
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and pie charts can be created for thematic codes and subcodes in MAXQDA. More complex analyses includ-
ing correlation analyses can also be carried out with the STATS module in MAXQDA. 

Phase 6: Synthesizing your results and writing up the review 

After most of the work has been completed in the first five phases, it is time to summarize your findings. 
When writing your review, the preparatory work of the first five phases comes into effect, that is to say, the 
results of the previous work should prepare you to write a well-structured text. In other words, you can build 
on the memos prepared in phases 5 and 6, as well as the displays such as summary tables, and visual repre-
sentations, to write up your review. 

There are two types of reviews: 

1. A review in the form of a qualitative description of results (descriptive literature review); occasionally, 
quantitative results can also be included, such as the number of sources, their distribution over time, ap-
parent trends, frequency of sub-topics, etc. The focus, however, remains a qualitative one. 

2. A review in the form of a quantitative meta-analysis with calculations of statistical parameters and 
measures. Here, the results of statistical procedures are central, as in the case of a meta-analysis of atti-
tude-behavior research, where average correlations in various spheres of activity are calculated and com-
municated. 

According to Fink (2019), both types of literature reviews should always contain the following four parts: 

• Purpose and objectives of the review 

• Methods and sampling 

• Results 

• Conclusions 

In the case of a quantitative meta-analysis, the methods section should be expanded with particular atten-
tion to the description and substantiation of the statistical methods used. 

When writing your review, the following MAXQDA tools can provide valuable assistance:  

• The Simple and the Complex Coding Query, with which you can locate previously classified text seg-

ments and text passages you have previously flagged as suitable for quotation. 
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• Memos, particularly the free memos written in phase 5 of the work on the review, from which you can 
copy and insert passages into the final text. 

• Summary tables, with which compressed summaries of sources can be effectively compared and repre-
sented. You can also integrate summary tables into your review. 

• The word frequency functions of MAXDictio, with which you can represent the usage of specific search 
items and semantic contexts. 

• The graphical display options of MAXMaps, which in particular allow you to create concept maps. 



26 Literature Reviews with MAXQDA 

 

Bibliography 

 

Boland, A., Cherry, G., & Dickson, R. (2017). Doing a Systematic Review: A Student’s Guide (2nd ed.). 
Thousand Oaks, CA: SAGE. 

Creswell, J. W. (2016). 30 essential skills for the qualitative researcher. Thousand Oaks, CA: SAGE. 

Fink, A. (2019). Conducting research literature reviews: From the internet to paper (5th ed.). Thousand Oaks, 
CA: SAGE. 

Gough, D., Oliver, S., & Thomas, J. (2017). An introduction to systematic reviews (2nd ed.). Thousand Oaks, 
CA: SAGE. 

Hart, C. (2017). Doing a literature review: Releasing the research imagination (2nd ed.). Thousand Oaks, CA: 
SAGE. 

Heyvaert, M., Hannes, K., & Onghena, P. (2016). Using mixed methods research synthesis for literature 
reviews. Thousand Oaks, CA: SAGE. 

Kuckartz, U., & Rädiker, S. (2019). Analyzing qualitative data with MAXQDA. Text, audio, and video. 
Schweiz, Cham: Springer Nature Switzerland. 

Meyer, U.-K. (2014, May 28). MAXQDA11 Tip of the month: How I manage my excerpts with MAXQDA 
[blog post]. Retrieved November 5, 2018, from MAXQDA Blog website: https://www.maxqda.com/tip-
month-manage-excerpts-with-maxqda 

Sauerborn, E. (2014, August 18). MAXQDA11 Tip of the month: How I manage my literature with MAXQDA 
[blog post]. Retrieved November 5, 2018, from MAXQDA Blog website: 
https://www.maxqda.com/managing-literature-maxqda 

 

  



Literature Reviews with MAXQDA 27 

 

Thank you for reading 

We hope you enjoyed this guide. Of course, MAXQDA offers plenty more. With MAXQDA you can: 

• Transcribe audio and video files 

• Import and analyze Twitter and YouTube data 

• Analyze focus groups 

• Visualize data 

• Generate reports 

• Conduct quantitative content analyses 

• and much more... 

Visit our website at www.maxqda.com to find out more about MAXQDA‘s many features and functions. 

 

 

Event: MQIC – MAXQDA International Conference 

The annual MAXQDA International Conference brings together MAXQDA users from all over the world. The 
conference offers you a varied program of workshops, poster sessions, best practice roundtables and lec-
tures on MAXQDA and mixed methods research. 

You can find more information about the conference at www.mqic-berlin.com
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